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INTRODUCTIONTODBOPTIMIZER

INTRODUCTION TO DB OPTIMIZER

IDERA DB Optimizer simplifies SQL optimization and development with many features for
improving productivity and reducing errors. A rich SQL IDE with statement tuning, data source
profiling, code completion, real-time error checking, code formatting, and sophisticated object
validation tools helps streamline coding tasks. DB Optimizer's user interface helps improve
overall productivity with integrated development, monitoring, and tuning components. DB
Optimizer offers native support for IBM® DB2® for LUW, Oracle®, Microsoft® SQL Server and
Sybase® as well as JDBC support for other DBMSs. It is available as a stand-alone application, or
as an Eclipse plug-in. DB Optimizer is structured and composed into three main interface parts.
This design provides a comprehensive workflow that enables development, query analysis, and
tuning capabilities. This workflow, in turn, leads to more efficient task management in terms of
time and efficiency, overall.

ABOUT THIS DOCUMENT

This document helps you install DB Optimizer and introduces you to the basic functionality of DB
Optimizer.

NOTE: For the latest versions of DB Optimizer documents and for information that will help
you install and upgrade, including technical requirements and databases supported,
see the IDERA documentation website. Always make sure to consult the README
for the latest breaking updates at www.idera.com/support/productdocuments.

MAJOR INTERFACE COMPONENTS

The three major interface components of DB Optimizer are as follows:

SQL Profiler: Provides continuous data source monitoring that builds a statistical model or
profile, of the specified data source and highlights top SQL, event, and session activity. This
component is used to locate and diagnose problematic SOL code and event-based bottlenecks
via its graphical interface, which is used to identify problem areas and drill down to individual,
problematic statements. Additionally, Profiler enables the investigation of execution and wait
time event details for individual stored routines. Profiling Details of the SQL Profiler have been
expanded to show Session Details for Sybase, and for SQL Server and the SQL that ran in the
selected session for Sybase, SQL Server, and DB2.
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SQL Tuner: Provides an easy and optimal way to discover efficient paths for queries that may
not be performing as quickly or as efficiently as they could be. Tuner enables the optimization of
poorly performing SQL code through the detection and modification of execution paths in data
retrieval through hint injections. Users are supplied with a list of possible cases generated by
Tuner, and can select and update a statement with the most efficient path to reduce load and
improve efficiency, overall. The Analysis tab of the tuner provides a graphical diagram of an SQL
query to show how the tables in the query would be joined to satisfy the query and also provides
suggestions for the creation of indexes that may increase query performance.

SQL Editor: Simplifies SQL development by utilizing features that improve productivity and
reduce errors. It provides a rich interface that offers code completion, real-time error checking,
code formatting, and sophisticated object validation tools. In context with SQL Profiler and SQL
Tuner, it provides an interface for viewing and editing SQL files and database packages, as
accessed through Profiler and Tuner functionality.
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INSTALLATION

This section helps you install DB Optimizer. It is comprised of the following topics:

e |nstallation Issues

¢ |nstalling DB Optimizer

TECHNICAL REQUIREMENTS

For information on the technical requirements of DB Optimizer, including supported operating
systems and databases supported, see the Readme at
//www.idera.com/support/productdocuments.

INSTALLATION ISSUES

DB Optimizer should be installed in a different directory than previous versions of DB Optimizer.
If DB Optimizer is installed in the same directory, the following error will arise at application
startup: “Unable to read workbench state. Workbench Ul layout will be reset.”

If a previous version is already installed on your machine, either change the default Workspace
or delete all files from the Workspace directory. The Workspace directory location appears
whenever you start DB Optimizer, and can be redefined from this dialog box. If the same
Workspace is indicated for the new version as was indicated previously, the following error will
arise: "Cannot restore workbench layout.”

If DB Optimizer is already running, you can also modify the Workspace directory by choosing File
> Switch Workspace > Other from the Main Menu.

INSTALLING DB OPTIMIZER

To install DB Optimizer, run the installer and follow the prompts provided by the Installation
Wizard. When the installation is complete, check the Readme file to see if it contains any known
issues or advisory notes that will affect your installation of the product.
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INSTALLATION

INSTALLING DB OPTIMIZER ON LINUX

1

10

Download the DB Optimizer installer and set the execution permissions as follows:
chmod 755 dbo_<version>_bin

Launch the installer in GUI mode from the console.

./dbo_<version>.bin

The DB Optimizer splash screen appears for a short time and afterwards the installer dialog
appears.

On the Introduction dialog, click Next.

On the License Agreement dialog, read the License Agreement, select “| accept the terms
of the License Agreement,” and then click Next.

On the Choose Install Set dialog, choose one of the two options and click Next.

Install as Standalone Application: This option installs DB Optimizer as a Standalone
Application, without any prerequisites.

Install as Eclipse Plug-in: This option requires Eclipse 3.6 or higher or an Eclipse Based RCP
application.

On the Choose Install Folder dialog, depending on the previously selected option, you can
select a destination folder where to install the Standalone version or you are required to
browse to the folder that contains Eclipse 3.6 (or higher) or an RCP application based on
Eclipse 3.6.

After selecting the desired folder, click Next.

On the Choose Link Folder dialog, you can change the location where the Application/
Uninstall links are created. Choose one of the options and click Next.

On the Pre-Installation Summary, review the installation details and click Install.

The Installing dialog shows the progress of the installation; it is closed when the installation
is complete.

When the Install Complete dialog appears, you can select Start IDERA DB
Optimizer and click Done in order to start the application for a first time use.

Licensing DB Optimizer

Registering a License at Application Startup

Shortly after downloading a trial version of an IDERA product, you should receive an email with
a serial number, which must be registered as follows. These instructions also apply if you have

purchased a product and received a serial number prior to running the application for the first

time, or if the trial period has expired.
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Start the application.

The IDERA License Registration dialog appears.
Copy the serial number from the email, and then paste it into the Serial Number field.

Enter your Embarcadero Developer Network (EDN) account credentials in the Login or
Email and Password fields.

If you have not previously created an EDN account, or have forgotten your password, click |
need to create ... or |'ve lost my password.

Click Register.

The activation file should be downloaded and installed automatically. If this does not
happen, click the Trouble Connecting? Try Web Registration link and follow the prompts.

Registering a License after Application Startup

The following instructions assume that you have received a license by email and that you
currently have a valid trial license. If you did not install a trial version or if the trial period has
expired, follow the instructions in "Registering a License at Application Startup" on page 7
instead.

1

2

Click Help > Launch License Manager.
In the License Manager dialog, click Serial > Add.

Copy the serial number from the email, paste it into the Add Serial Number dialog, and
then click OK.

Expand Unregistered Serial Numbers, right-click the serial number just added, and then
click Register.

A registration dialog appears.

NOTE: The Registration Code box shows a machine-specific identifier required with other
registration methods.

Ensure that Register using Online Registration is selected.
Provide Developer Network credentials in the Login or Email and Password fields.
Click Register.

The activation file should download and install automatically. If this does not happen, click
the Trouble Connecting? Try Web Registration link and follow the prompts.
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GETTING STARTED WITH DB OPTIMIZER

The following tutorial sessions enable you to get started using DB Optimizer. Their purpose is to
provide you with the foundation needed to fully utilize the features and benefits of DB Optimizer,
and apply them to your own enterprise. This section contains information on how to register data
sources from your enterprise, and how to profile, analyze, and tune SQL statements, sessions,
and events for the purpose of optimizing the efficiency of your data sources, as well as identify
and prevent system bottlenecks and other wait-related issues.

This guide is comprised of the following sections:

e Start DB Optimizer on page 9

Overview of the User Interface on page 9

Working with Data Source Explorer on page 11

Profiling a Data Source on page 14

Tuning SQOL Statements on page 21

SQL Code Assist and Execution on page 40

START DB OPTIMIZER

From the Desktop, choose the Windows Start menu and then select Programs > IDERA
> |DERA DB Optimizer X.X > IDERA DB Optimizer X.X.

NOTE: Once you have started the application, you can select Help from the menu bar
to find additional resources that complement and build upon the features and
tasks presented in this guide.

OVERVIEW OF THE USER INTERFACE

The DB Optimizer application environment is known as the Workbench that provides an
interface through which you manage data sources and analyze and tune statements. The
Workbench is composed of common interface elements that provide tools to accomplish these
tasks. These objects provide a uniform system for working with tuning jobs, profile sessions, and
data sources.
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The Workbench provides an environment to build profiling sessions and tune query
statements. The Workbench Space is composed of views, editors, and the menu bar and
command toolbar. Views and editors enable you to perform DB Optimizer functions and work
tasks, as well as manage resources.

e Views are used to navigate a hierarchy of information, open Editors or display the properties
of various application elements. For example, the Data Source Explorer view provides a tree
of all data sources in the environment and the comparison jobs associated with each. You
can launch these jobs directly from Data Source Explorer, modify the connection properties
of data sources, or create and edit configuration archives from this View.

e Editors are used to access DB Optimizer functionality. For example, the SQL Editor
provides a means to view, edit, and save SQL code. Editors are differentiated from Views in
that they operate on an individual level rather than a supportive one. The SQL Profiler and
SQL Tuner are also considered to be editors.

10
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® The Menu Bar and Command Toolbar contain commands that execute various functional
aspects of the application such as launching views and editors, navigation commands, and
environment preference settings. The command toolbar contains icons that represent
specific menu commands.

WORKING WITH DATA SOURCE EXPLORER

Data Source Explorer provides a tree view of all registered data sources. It breaks down the
components of each data source and categorizes databases and corresponding database
objects by object type and underlying SQL code. This feature provides you with a view of the
contents of data sources in your enterprise in an easily navigated and cataloged interface.

Hy Pl = S0l ProjectExpl | — O
T EEE

=l I=F Managed Diaka Sources (3)
=I-{=F Data Source Group ()
+-T=F Microsaft S0L Server (2]
=I-l=F Qracle (&)
= S8 ROMLABORCLEI_1 (Oracle 8.1,7.4)
+ l__I:;I Database Chjects
+- i ROMLABORCL_Z (Oracle 9.2,0,1)
+ fﬂ sfvpclb0l . embarcadera.com (Oracle 10
= S TORLABORCLE 2 (Oracle £,1.7.4)
+ l__I:;I Database Ohjecks

Data Source Explorer sorts databases and database objects by category within DB Optimizer. If
data sources are particularly large or complex, or you are only developing specific objects, you
can apply database object filters on the view in Data Source Explorer.

ADDING DATA SOURCES

In order to profile and tune statements, you need to register the data sources to be analyzed in
the environment by providing connection information and other details to DB Optimizer. Data
sources are registered and managed in Data Source Explorer. Each time you register a new data
source you need to specify its connection information and organize it in the View, as needed.
Once a data source has been registered, it remains stored in a catalog and does not need to be
registered again each time you open DB Optimizer. Furthermore, it can be used in multiple jobs,
archived, or otherwise “shared” with regards to the general functionality of the application.

11
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GETTING STARTEDWITHDB OPTIMIZER

The Data Source Explorer view provides an organizational tree of registered data sources and

the parameters associated with them.

To add a data source

1 Select Data Source Explorer and choose File > New > Data Source from the Menu

bar.

The New Data Source Wizard appears. Follow the prompts to register the data source.

Register a new data source

Chioose the server bype and location For your new data source,

Generate an unique name based on the alias or the host name

& MNew Data Source: New data source |:.®

Data source name:

Select a server bype: Select a data source group:

CtGeneric JDBC [= T=F Managed Data Sources

CHYIEM DEZ For LUy [=-1==* Data Source Group

CHiMicrosoft SOL Server === Micrasaft SOL Server

CHyCracle == Microsoft SOL Server

Cy5vbase ASE = 1=F wew

I=F Microsoft SQL Ser
1= Oracle
I=F Microsoft SQL Server
< | =

|:| Create a new server bype-specific subgroup
Select a categaory; | Mo category w |

@
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You can categorize data sources in order to color code them in the Data Source Explorer
which makes the data source easier to find when you have a long list of data sources. The data
source will be decorated with the color associated with the category selected for the data
source. A set of preconfigured categories include Development, Test, QA, and Production. You
can also create custom categories. Existing data sources can be categorized using the Data
Source Properties page; right-click a disconnected data source and select Properties.

BROWSING DATA SOURCES

To analyze and tune statements on data sources within your enterprise, you must access the data
source objects within the application. It is important to view databases and underlying code in an
organized manner, especially when maintaining a large system. Data Source Explorer's tree
structure can be used to view databases, tables, and other information about data sources.
Expand the nodes of each registered data source to view details about each data source. Data
Source Explorer is also used to launch profiling sessions, by enabling you to select the data
source that you want to execute, and then launching a profiling session from your selection.
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The Data Source Explorer tree provides a list of databases, and enables you to launch Optimizer
features, such as SQL Profiler, via the context menu. All objects listed in Data Source Explorer are
sorted by data source name. Additionally, you can view the underlying SQL code for an
individual database object.
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To browse a data source
1 Expand a data source node, providing credentials if prompted.

2 Expand additional subnodes to drill down through object types and then individual objects.

3 Double-click the Code subnode for a particular object to view the code in SQL Editor.

Notice in the previous screenshot, there are Profiling Repositories listed in the Data Source
Explorer. For Oracle data sources only, you can save your profiling sessions to the Profiling
Repository for later examination. We'll discuss this more later in "Saving a Profiling Session”
on page 20.

PROFILING A DATA SOURCE

NOTE: The SQL Profiler is not available in the “Basic” version of DB Optimizer.

SQL Profiler samples a data source and builds a statistical model of the load on the database.
Profiling is used to locate and diagnose problematic SQL code and event-based bottlenecks.
Profiler also enables you to investigate execution and wait time event details for individual
stored routines. Results are presented in the profiling editor, where you can identify problem
areas and view individual SQL statements, as needed.

14
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SQL Profiler is composed of the following diagnostic parts:

® The Load Graph provides a display of the overall load on the system. The bars represent

individual aspects of the data source.

* The Top Activity section displays where the load originates. Tabs available in this section
differ by platform, but typically available are the top SQL statements, the top events the
database spends time in, and the top activity sessions that may be causing issues in terms of

query time and response.

e The Profiling Details View displays detailed information for any item selected from Top
Activity. For example, examining a SQL statement from Top Activity displays the
identification parameters and the execution statistics of that specific statement selection.

STARTING A PROFILING SESSION

In order to access SQL Profiler, you need to run a profiling session on a data source registered in

Data Source Explorer.

15



GETTING STARTEDWITHDB OPTIMIZER

To run a profiling session
In Data Source Explorer, right-click on a data source and select Profile As > Data Source.

The profiling session begins.

7 progress 1T o
E-]_Prl:-ﬁling torlabsgloo 2
T

Initalizing session...

)

Once a profiling session launches, it runs until you stop it or it has run for its specified length of
time. You can stop a session by clicking the Stop icon on the right-hand side of the Profiling
progress bar.

When the profiling session is complete, the first two sections (Load Chart and Top Activity) will
be populated with information about the database load. You can then begin analyzing the data
and identifying problem areas.

ANALYZING SESSION DATA

The SQL Profiler is composed of three essential diagnostic views that provide information about
load on a particular database in the system. These views enable you to identify bottlenecks and
view details about specific queries that execute and wait over the course of a profiling session.

The following describe the three components of SQL Profiler, in descending order of granularity:
e Load Chart on page 16
® Top Activity on page 17

e Profiling Details on page 18

LOAD CHART

The Load Chart provides an overview of the load on the system, and is designed as a high level
entry point to reading session results. The colored bars represent individual aspects of the
database, and the graph can be used to discover bottlenecks.

16
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Time is displayed on the X axis, and the Y axis shows the average number of sessions waiting or
executing. Each support platform type has a specific set of wait event times. For example,
Sybase platforms will display CPU, Lock, Memory, I/O, Network, and Other categories. Use the
chart legend to understand the graph. It displays a color and code scheme for executing and
waiting session categories in the upper right-hand corner of the chart.

TopP ACTIVITY

Below the Load Graph, the Top Activity section displays where the load originates and outlines
items such as the top SQL statements, top events, and the top activity sessions on the database.
It is composed of a series of DBMS platform-specific tabs that provide detailed statistics on
individual SQL statements and sessions that are waiting or executing over the length of the
profiling session.

%% Ovewiewg = osaL {9 Events '-'rf:' Sessiunsé ﬁ Blockers »0 Oh_ieu:tI.r‘DE

User Marme | Prograrm [ SID | Serial# | Active %) Mack  ~
Il = STEM JDEC Thin Client : ulgariulll L4
|| SYSTEM IDBC Thin Client 102 I s rovvcbulgariul2

| SYSTEM IDEC Thin Client 136 743 [ 93.35 rowechulgariul2 -

While available tabs differ by platform, the most common are:

® The Overview tab provides summary information about SQL statements and events and
their activity levels, and sessions, their system process IDs and their activity level. You can
reorder the rows in any of the three sections of this tab. For example, clicking the Event
column in the Events section changes the alphabetical order to ascending or descending.

e The SQL tab provides information about SQL statements and procedures. This includes all
INSERT, SELECT, DELETE, and UPDATE statements that are executing or waiting to execute
over the length of the profiling session.

® The Events tab displays information about wait events, and should be used to tune at the
application or database configuration level. For example, if the top events are locks, then
application logic needs to be examined. If the top events are related to database
configuration, then the database setup should be investigated.

e The Sessions tab displays information about sessions, and can be used to discover sessions
that are very active or bottlenecked.

17
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* The Object I/O tab provides information about I/O when profiling an Oracle data source.

® The Procedures tab provides information about the procedures running in the session when
profiling a SQL Server or Sybase data source.

PROFILING DETAILS
When you select any item from Top Activity, details are displayed on the Profiling Details view.

TIP:  You may have to select Windows > Show View > Profiling Details to display
the Profiling Details view.

The tabs that compose the Profiling Details view are dependent on the nature of the object
selected in Top Activity, in order to reflect that item’s specific information. The tabs are also
dependent on the data source platform. For example, the Object 1/O tab is available only for
the Oracle platform whereas the Procedures tab is available only for the SQL Server, Sybase,
and Oracle platforms.

0¥ sl Text | @ SQL Details | {5 Events | &7 Sessions | B Children Details | 7 Object [jO
SELECT A

T.OWUNER,
T.IO0T HAME,
*YES! w

Depending on the data source platform you have specified, the tabs that appear in the view will
be different, in order to accommodate the parameter specifics of the statement you have
selected.

Depending on the top activity selected and the profiled platform types, some tabs may not be
available.

NOTE: When right-clicking on a SQL statement in the Top Activity section in the SQL Profiler,
if the SQL statement is run by a different user than the user who is running DB
Optimizer, then the User Mismatch dialog appears, with an example of the following
message: This query was executed by [SOE] and you are currently connected
as [system]. We recommend you reconnect as [SOE] to tune the SQL. Would
you like to continue anyway? This message indicates that the statement is being
tuned by a user other than the user who originally ran the query, and tables may be
missing based on the different schemas. Click OK to run the query, or click Cancel and
run the tuning job under the original user.

VIEW SESSION DETAILS

1 Inthe Profile Session area of the SQL Profiler, inthe Sessions column click anywhere in
the row of an application that ran during the profiling session.

2 Inthe Profiling Details area, click the Sessions tab.

Details of the session are displayed.

18
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VIEW SQL

1 Inthe Profile Session area of the SQL Profiler, click anywhere in the row of an
application that ran during the profiling session.

2 Inthe Profiling Details area, click the SQL Text or SQL tab.
The associated SQL test is displayed.

D 5Ol Text

SELECT /#*+ rule #/ »
bucket,
endpoint,
col#¥,
epvalue
FROM histgrm®
WHEERE
obj$ = :1 AND
intcol#
rowg = :3
ORDER BY bucket

4

TIP:  From the SQL tab you can easily tune a statement by right-clicking a statement on the
SQL tab to initiate the tuner, which then opens with the selected statement in the Ad
hoc SQL tab of the Tuner Input.

19



GETTING STARTEDWITHDB OPTIMIZER

SAVING A PROFILING SESSION

A profiling session can be saved to a file with an .oar suffix that contains the name of the data
source. When profiling Oracle data sources you can alternatively save the session data to the
Profiling Repository. This enables you to open the file at a later time for analysis.

SAVE A PROFILING SESSION AS AN .OAR FILE

1 Select the profiling session and then choose File > Save As. Specify the project location you
want to save the file in and modify the file name, as needed. Click OK. The project is added
to SQL Project Explorer.

'ﬂ Save Asg

Save As

Save file to another location,

Enter or select the parent Folder:

| SQLProject

4
|
J

| B slProject

Eile name: | sfvpclbdl embarcadero. com.oar

'f?:‘ [ oK H Cancel ]

Once you have saved a profiling session, it appears in the SQL Project Explorer under the name
you saved it as. It can be opened again by double-clicking the project name.

SAVE A PROFILING SESSION IN THE PROFILING REPOSITORY

You can also have the session saved automatically as a Profiling Repository file in an Oracle data

source. This allows you to profile your data source for a longer period of time, for days or even
weeks.

1 Right-click the data source you want to profile and select Profile As > Profile
Configurations.

2 Inthe Profile Configurations dialog, select Save to data source and then select the
data source where you want to save the profile sessions.

The saved session file, named using the date and time when the profiling session was stopped,
can be viewed from the Data Source Explorer and thus available to share with other DB
Optimizer users.
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IMPORTING STATEMENTS TO SQL TUNER

SQL Profiler enables you to submit one or more statements into SQL Tuner. This enables you to
take advantage of Tuner’s hint-based and transformation-based suggestions if you want to tune
a problem statement that you detected over the course of a profiling session.

£ Cl'-.-'er\.-'iew.g 55" 0L {9 Ewents Ig-?‘j Sessiu:unsg ﬁ
SOQL Statements
Staternent | DB Activity (26) =

| 5 3¢ DELETE FROM..., 0, 0,0) [ &

SELECT CS S| eese——

|| -« SELECT*F

| 5 B UNKNOW 2 capy

[| & ¥% insert into

| SELECT &, Explain Plan

[N Y Tune X
1 | 3

Cormpare

Context menu commands in SQL Profiler enable you to import statements to a tuning job
directly from the Profiler interface.

Import a statement from SQL Profiler into SQL Tuner

Select one or more statements in Profiler, right-click and select Tune from the context
menu. SQL Tuner opens and contains the selected statements in a new tuning job. You can

now proceed to tune the problematic statements.

TUNING SQL STATEMENTS

SQL Tuner provides an easy and optimal way to discover efficient paths for queries that may not
be performing as quickly or as efficiently as they could be. Tuner enables the optimization of

poorly-performing SQL code through the detection and modification of execution paths used in
data retrieval. This is primarily performed through hint injection, and index and statistics analysis.
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2] mmstttun 23 =0
b 1§ Oracle ¥ T TORLABSCORCL (MOYIES) (10.2.0.1)
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Tuning Staten Generake cases Perform detall ai Execute gach generated case 3 . h:i t!j

Statement Time | -~
Marme | Schema Text Tables Wiayes Elapsed (s} | Improved {s)
& [seEcT 1 MOVIES select from ' 5| 0 063 0.63
& [MseEectz MOVIES select from 4 0 0.04 0.04
E E SELECT 3 FOVIES select From g u] 0.09 009
2 SELECT 4 FIOVIES select from 5 1] 10.10 10,10
l":l m COIC~TCC AT el b B, [=] [ [ M al=] [ Wil :
4 | ¥
Generated Cases g
5L Statements and Cases |3 cost | Executi istics | %
Walue Elapsed Time (s} | Physic
M SELECT 1 select from MOVIES. customer, | a0l oe3] |
g | KR SEECTZ select from MOVIES.customer, 11.0 0.0
3 &, SELECT 3 select from MOVIES.customer, 25.0 0.09
e - & SELECT 4 select from MOVIES.customer, 22.0 10,10
;}:'—_| B SELECTS seleck from MOVIES.cuskomer, 25.0 0.03
g R SELECT 6 select from HR.EMP_DETAILS_VIEW
eFl - & SELECT 7 select from MOVIES.customer, 21.0 0.07

For example, different joining methods such as nested loops or hash joins can be used and will
be tested, as appropriate. Tuning will select alternate paths, and enable you to change the
original path to one of the alternates. Execution paths slower than the original path are
eliminated, which enables you to select the quickest of the returned selections and improve
query times, overall.

This enables the DBA to correctly optimize queries in the cases where the native optimizer
failed.
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CREATING A NEW TUNING JOB

New tuning jobs are created from scratch where you can specify the statements to be tuned from
a variety of sources, or statements can be directly imported from existing profiling sessions on
data sources currently registered in the environment.

[#] mattbun (L] ProffeTorLaBscorcL. (LS *unbitled Tuning Job B2 M: =t

b Microsoft SOL Server b [y TORLABSQLOD_L (8.0.2039.0)

= Overview ‘ F—" Amalysis

Sa Py
']
1]

£ Overview (T
ST Mes S04 Tewt
Tuning State  [Flaeeratecase  [Performdetal [ Execute each generated case | 1 "® I estract from Datzhase object
|54 Impaott Fram File (Workspace)
Staterrert I
|52 Trnpeoet: Friam File (Sesham)
Mams Cakalag Schema Texk Tables Wiz Elfevrevur—
|= ¥

To create a new tuning job
1 If you determined from a profiling session that a specific SQL statement should be tuned, in
the Profile Session, right-click the statement and select Tune as follows:

£E Cwerview ES a0 {P} Events g::'j Sessions | 80 Object IjO
SOL Statements Events
Stakernent 11 Event DE
*3 INSERT INTO ,..'dmi_locks' || il CPU [ |
+3 INSERT INTO ... 'Free',1,'R || db file sequential read |

& select * FL O NTR_DATA L ] rull event |
i ELECT ' F...PE —

Croanize By r

& Copy

i@ Profiling Details &3 <22 Explain Plan

Tune
SOL: SELECT "X' FROM iERE DBJECT_NAME =:1

E% S0l Text | @8 500 Do s ooy —ssions | T8 Children Detail

OR

Select File > New > Tuning Job, or click the New Tuning Job icon on the Toolbar.
SQL Tuner opens and you can proceed to set up the parameters of the new job.

Once you have defined the input of the tuning job, you can save the file with a . tun suffix
via the Save As... command. The job is added to the SQL Project Explorer and can be re-
opened and re-run at any time once it is saved to the system.
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ADDING SQL STATEMENTS TO A TUNING JOB

Once you have created a name for the tuning job and indicated its source, you can add SQL
statements that you want the job to tune. Statements are added to a job via the options
available in the SQL list on the Overview tab. All standard DML statements (SELECT, INSERT,
DELETE, UPDATE) are viable for the tuning procedure. On SQL Server 2008 and higher, MERGE
statements can also be tuned.

LE] *Unktied Turing Jab 3 53 =8
b rfy e bR ROMLAEORCLE ] (5.1.7.4)

= Uwerview }" Amalysis

=5 Dverview e ®

Tuning Statements ¥ Gereraba cases [Credform detal anatysis [CJExene eemw4%; i)

| Tt friom Fbe QWarkspace)

Staemant Tine B, Jmpert Frem File (Syctem)
Tk Sehma Tiet Tahles WinEs Flapsad (5] Inprered (2] %, 5can Oracke 554

There are four or five different ways to add SQL statements to a job, as reflected by the options
available in the SQL list as shown previously:

¢ New SQL Text: Copy/paste SQL statements to the New SQL Text window or write
queries by hand. You can also paste a statement directly into the Overview statement grid
by copying the statement and then right-clicking anywhere on that grid and selecting Paste.

e Extract from Database Object: Drag and drop database objects from the Data Source
Explorer to the Statements grid on the Overview tab.

* Import from File (Workspace) and Import from File (System): Browse the workspace
or file system and select SQL files.

e Scan Oracle SGA: For the Oracle platform only, you can also scan the System Global Area
(SGA) for statements to tune.

ADD NEw SQL TEXT

From the SQL list, select New SQL Text and manually type an SQL statement in the window.
Alternatively, copy/paste the statement from another source.
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£} New SOL Text ieaiiEl e

Add Tuning Statement 5 u L

Add a SQL statement. t]]

SELECT -
First,
Last
FROM
Employee
WHERE
Gender = "F"

Apply

b0kl (unbanes)

ADD A DATABASE OBJECT

From the SQL list, select Extract from Database Object. The Data Source Objects
Selection dialog appears. Type an object name prefix or pattern in the field provided and
choose a statement from the window as it populates to match what you typed.

& Data Source Objects Selection

Enter object name prefix or patkern (7 = any character, * = any skring): -

) i

Matching objects:

& COUNT_TIME_INTERWAL (Package) - SYSTEM 25
o & DBMS REPCAT AUTH (Package) - SYSTEM
%’ DRG (Package)

Al CRAN MERT FATA (Facle—ant s

Configure data source indexing. ..

@j L (0] 4 H Cancel ]

You can also drag an object, such as a Packages, Package Bodies, Views, and Functions, from the
Data Source Explorer to the grid on the Overview tab. In order to drag a database object on the
Overview tab, the database object in the Data Source Explorer must be in the same database
that displays in the bread crumbs at the top of the Tuning window.
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ADD A SAVED SQL FILE

From the SQL list, select Import from File (Workspace) or Import from File (File System),
depending on where the file you want to add is stored. Select a file from the dialog that appears
and it will be added to the tuning job.

ADD ACTIVE SQL IN SGA

From the SQL list, select Scan Oracle SGA. Specify any filters as required and then click Next.
From the list of SQL statements retrieved from the SGA, select those you want to optimize, and
then click Finish. The selected statements are copied to the tuning job.

3 Scan SGA

SGA filters
Specify the filkering criteria for active 0L in the 5G4, . E

Filker Critetia

1
{ 5 A . F
Mawximun retrieved querles:@! *i|

Sort by | CPU Time: W

Advanced Filkers

Lser; | W i

Farsing Schema:

|
Madule: | W
Action: ! w
Service:

RUNNING A TUNING JOB

After you add SQL statements to the job, click the Overview tab. Once you choose your tuning
options and click the Run Job icon, the DML is parsed from the statements and added to the
Generated Cases area. The Generated Cases are alternative execution paths or explain paths
that could be better or worse than the default path the database uses. When these cases are
executed you can use the execution statistics to determine which case would optimize
performance.
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Each extracted statement is listed by Name and Text. Additionally, each statement has a Cost,
Elapsed Time, and Other Execution Statistics value that provide information on how effectively
each case executes on the specified data source. These parameters let you compare the
efficiency of the original statements to the cases generated by the tuning process when it is
executed.

TIP:  You can double-click a generated case to view or edit the SQL source of the statement.

Tuningtatusndicator Columrset Run/Cancelob
Enabl&xecution Expand/Collapse Controls
CheclBox . Control
Schemandcatalog Pans&iz€ontrol
Selectors Increase/Decrease
L.-? Overview FP Analys /
! :
a, ; Lyfhring detected P EIE*" B @
Tuning [JGersrate Cages [Jrerform detal analysf Exefute asch generated case | w r?}
) Sfatemant ) : ] ﬂ|_!'u! J ) An
) Mame ¥ Schema Text Tables Visws Elapsed (5] improved (5} Cases Inde:
T [seect2 MOVIES | select from BROKER, 5.32 6.32 0
T HseEcT 1 .00 .00 10
< >
Generated Cases Generate€Case FilteControl g 3
Expand/Coltaps€ontrol
statements and Cases ¥  Cost #Exgutl...istics ], » Qther
Teext | Valus | Elapsed Time (s} | Physical Reads | Lo
el E select from BROKER, CLIEMT _TRAMSACTION, 34014.0 6.32 2
el . sfarmation 2740 0.03 o
pel " SELECT 1 select from cient_traneaction, dient, 4.0 0.00 i}
FE| LISE_HASH 140 0,00 a
e ORDERED 8.0 0.00 1]
el NO_LUSE_NL 16.0 0.00 1]
= EADINGE gi‘;{g&fﬁg 8.0 0.00 0
e LEADING3 ranstormatroitase 0.0 0.01 ]
el LEADINGZ Hint-Based 7.0 0.01 o
LS LEADING 1 / Cases 40 0.00 0
el iNDEY_FFS 4.0 .00 1]
el FLLL &4.0 .00 1]
o3 FIAST_ROWS 40 0.00 o
< >

The Tuning Status Indicator provides the status of each statement or case, and indicates if
they are ready for execution. In some cases, SQL code may need to be corrected or bind
variables may need to be set prior to executing statements. When you try to tune a statement
containing a bind variable, you are now warned that either the type is not set or the value is not
set.

Use the check boxes to select which statements and cases you want to run and then click the
Run icon in the upper right-hand corner of the screen. The Execute each generated case
field enables you to execute each selected statement or case.
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Use the Schema and Catalog Selectors to select a schema and catalog for the tuning job. The
catalog selector is available only for SQL Server and Sybase data sources. By specifying the
schema and catalog, the tuner can use the paths of the schema and catalog selected to find the
tables queried in the job rather that use the paths of the schema and catalog used to connect to
the data source. If you change the schema or catalog used in a tuning statement, you will need
to refresh the tuning statements in order for new cases to be generated, which take into
consideration the schema used. Right-click a tuning statement and select Refresh Tuning
Statements.

Once you have executed a tuning job, the Generated Cases tab will reflect SQL Tuner’s analysis
of the specified statements. Once these have been analyzed, you can proceed to modifying the
Tuner results and applying specified cases on the data source to optimize its performance.

RUN A TUNING JOB
1 Once you have a SQL statement that is a tuning candidate, navigate to the Overview tab.

2 Inthe Tuning Statements area, select the checkbox next to the Statement name that you
want to analyze and then:

To analyze the SQL statements, click Generate cases.

To perform the analysis that populates the Analysis tab now, click Perform detail
analysis. Otherwise, this analysis is performed when you click the Analysis tab.

To have the system generate execution statistics, click Execute each generated case and
then select the number of times the system should execute each generated case. Multiple
executions can verify that the case results are not skewed by caching. For example, the first
time a query is run, data might be read off of disk, which is slow, and the second time the
data might be in cache and run faster. Thus, one case might seem faster than another but it
could be just benefiting from the effects of caching. Generally, you only need to execute the
cases once, but it may be beneficial to execute the cases multiple times to see if the
response times and statistics stay the same.

3 Then click the Run Job icon at the top right-hand side of the window. The tuning job runs,
analyzing each statement and case, and providing values in the appropriate columns.

ANALYZING TUNER RESULTS ON THE OVERVIEW TAB

When you have executed a tuning job, the Generated Cases area of the Overview tab reflects
Tuner's analysis of the specified statements and cases. The Generated cases create alternative
execution or explain paths that could be more or less efficient than the default path the
databases uses. Executing these cases provides the statistics necessary to optimize
performance.
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Once a tuning job has executed, use the Cost and Execution Statistics value columns to
determine the fastest execution path for each statement. The Cost column shows the
performance cost of an execution path as determined by the database. The Execution
Statistics are the actual results of running the SQL statement using the generated case. This is
where DB Optimizer can help you find where the database default path is actually not the
optimal path. The Elapsed Time(s) and Results columns can more accurately show the most
efficient execution path.

In the Cost and Execution Statistics columns, the values of the original statement are
considered to be the baseline values. A Cost column can be expanded to provide a graphical
representation of the values for statements and cases. Similarly, the Execution Statistics column
can also be expanded to display a graphical representation of values as well. The bar length and
colors are intended as an aid in comparing values, particularly among cases.

0,78 R

1,543 I
0,655 R

0.499

0,797 R

EI-SEE E——

Case query times based on the original statement can be represented as colored bars on the
Generated Cases area of the Overview tab to help you determine the fastest execution path for
the given selections. The baseline value of the original statement spans half the width of the
column, in terms of bar length. For cases of the original statement, if one or more cases show a
degradation value, the largest value will span the width of the column. Bar lengths for all other
cases will then be displayed in comparison length to the highest degradation value.

The cost and execution results are color-coded as follows:

e Light blue: These cases are within the degradation and improvement threshold. Applying
these changes may marginally improve or degrade the efficiency of the SQL statement.

. : These cases have values less than the improvement threshold. There is a high
probability that changing the SQL statement with this alternative execution path will
improve efficiency.

e Red: These cases have values higher than the improvement threshold. Implementing these
changes will degrade the efficiency of the SQL statement.

DETERMINE THE BEST CASES FOR STATEMENT EXECUTION PATH TIME

Once the tuning job has executed, view the Generated Cases area of the Overview tab
and determine the best possible case in terms of the Execution Statistics column values.
This will indicate the most optimized query path for a given statement. Once you have
determined the best case, you can execute that case on the specified data source and alter
the database code to run the statement as that case on the native environment.

If you don't find an acceptably fast path, go to the Analysis tab. The Analysis tab can
identify missing indexes and by examining the diagram you may be able to determine if
there is something wrong with the SQL or schema.

29



GETTING STARTEDWITHDB OPTIMIZER

FINDING MISSING INDEXES AND SQL PROBLEMS

The tuner performs the index and SQL analysis as part of the tuner run job performed on the
Overview tab if Perform Detail Analysis is selected. Otherwise, the analysis is performed when
you click the Analysis tab.

b o Oracle b S sfvpelbl | embarcadero comi( (10,2.0,1)
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DB Optimizer can parse an SQL query and analyze the indexes and constraints on the tables in
the query and display the query in graphical format on the Visual SQL Tuning (VST) diagram. The
VST diagram can be displayed in either Summary Mode or Detail Mode. The VST diagram helps
developers, designers, and DBAs see flaws in the schema design such as Cartesians joins,
implied Cartesians joins and many-to-many relationships. The VST diagram also helps the user to
more quickly understand the components of an SQL query, thus accelerating trouble- shooting
and analysis.

This section is comprised of the following topics:

¢ Finding Missing Indexes on page 31

e Exploring the VST Diagram on page 32

¢ Finding Problematic SOL or Schema on page 38
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FINDING MISSING INDEXES
Missing indexes are color-coded orange in the Collect and create indexes area of the
Overview tab. Creating a missing index can improve the execution path of the SQL statement
being analyzed.

TIP: Indexes that are used are color-coded green. Indexes that exist in the table but are not

used in this execution path are color-coded grey. Indexes that are usable but not used
by the current execution path are color-coded blue.

[E| Inde: Analysis | [( Table Statistics | 5 Colurn Statistics And Histograms | [0 Oudines

Callect and creste indexes ‘E._I

- Index Mame Table Owiner Table Mame Colurmn Mame
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® [line_cusToMER D MOVIES CUSTOMER CUSTOMERID, LASTHAME |
¥ DOAmoviERENTAL P MOVTES MOVTERENTA RENTALID
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EXPLORING THE VST DIAGRAM

Select statement of interest: [SELECT 1 w b{)(h B @

¥5 27 ol & Diagram Legend o
Table

| I3 RENTALITEM (RD) |

Vi

Materialized Yiew

E R g m

Sub-quety

=

Common Table Expression

rﬂ

Calurnn

| B MOVIERENTAL (MR) | &G MOT IN (2)

Index
Primary key
Unique Keny
Filkered object

Z=—=T Many bo Marey (M:M)
—== Parent o Child {1:M)
nigque (1:1)
S5 GUTER 101N

£ > EXISTS [ IM w

| (3 cusTOMER (C5)| S SUBQUERY (1)

A P i

Legend
Display/Hide Diagram Legend
Display/Hide Explain Plan
Display/Hide Ratio Counts
Display Detail Mode or Summary Mode
Zoom In

Zoom Out

DISPLAYING OR HIDING THE DIAGRAM LEGEND
Click the Diagram Legend toggle Ef]] to view the legend and then click it again to hide it.

All the icons used in the VST diagram are identified in the Diagram Legend.
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Diagram Legend
Tahble

View
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AF— ERISTS | IN v

DISPLAYING OR HIDING THE EXPLAIN PLAN
NOTE: The Explain Plan is available only for the Oracle 10g and 11g platforms.

Hover the mouse over the VST diagram to see the Explain Plan icon [ £%and then click it to
view the Explain Plan Overlay. Click the Explain Plan icon again to hide the overlay.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the
query plan, with operations (such as nested loops, sorts, and joins) showing connecting
tables and other operations.

| REr:-lT.ﬂ.LITEM (RI) |
-

]
MOVIERENTAL (MR 00
: [ 3 moviecory (me) |

[

Son
(3 cusToneR (cs)| | = MOVIERENTAL |

Hover the mouse over the objects or relationships in the overlay to view additional details.
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DISPLAYING OR HIDING TABLE COUNTS AND RATIOS
To view or hide table counts, two table join sizes and filtered result set ratios, click the Ratios

and Counts icon [12":]

"“'.:1 L
182 0 |

1 10000
& SUBQUERY (1) | (3 RENTALITEM (RI)
4} 1003
|
15?1 10000
S0 4\ i}
| B2 MOVIERENTAL (MR) | &6 NOT IN (2)

Looo

[

|13 cusTOMER (C5)
10056

Green numbers at the top left of table represent the total number of rows in that table. In the
above example, the MOVIERENTAL (MR) table has 5000 rows.

Blue percentage at the bottom right of the table represent the percentage of rows in that table
that meet the selection criteria. In the above example, 100 percent of the rows in the
RENTALITEM (RI) table have met the selection criteria.

The numbers on the table joins indicate the total number of rows that meet the selection criteria
for both tables.

You can also view the SQL Query that created a relationship by hovering over the relationship. If
the tooltip content is larger than the size of the tooltip rectangle, you can hover the mouse on
top of the tooltip for a second, and then it will turn into a dialog you can re-size, scroll in, and
select text from to copy into the Clipboard.
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1 10000
500( | 3] RENTALITEM (RI)

| & movierenTAL | st
N /]
Y

100
1591 Cardinality: Master-Detail
\\ / Joined Row Count: 10000
cong o .
y Relat 3
[ B2 movierenTAL (0
ri. RENTALID = mr RENTALID

Columns:

o

5”|”” MOVIERENTAL.RENTALID

- REMTALITEM.RENTALID

| [F cUSTOMER (s, SQL Count Statement:

100 SELECT COUNT (%)
FROM
MOVIES.MOVIERENTAL MR,
MOVIES.RENTALITEM RI
WHERE ri,RENTALID = mr.RENTALID

DISPLAYING OR HIDING TABLE COLUMNS AND INDEXES

Click the Detail/Summary switch to display or hide details of the table display,
including table columns and indexes.

Only fields that are used in the WHERE clause are displayed in detail mode. For information
on interpreting the icons used in Detail mode, activate the Diagram Legend.

TIP:  You can also switch between Summary Mode and Detail Mode for a specific table
or view by double-clicking the object name.

NOTE: You can move tables in the diagram by clicking and dragging them to the desired
location. The position of the connecting lines is automatically adjusted.

VIEWING ALL FIELDS IN A TABLE

Hover the mouse over the table name to view all fields in the table in a pop-up window.

The illustration below shows the pop-up window that appears when hovering over the table.
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REMTALITEM (RI)

[5E ITEMNUMBER.: NUMBER
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¥ B REMTALITEM_PK

(9]
MOYIEREMTAL (MR &g NOT I (2)
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ID%_MOVIEREMTAL 0
MOYIEREMTAL_FK1
MOYIERENTAL FEZ
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MOVIEREMTAL_IEZ
¥ MOVIEREMTAL_PK

V R

VIEWING OBJECT SQL
Hovering the mouse over the table name, field, or index displays the SQL required to create

that object.
/ [
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VIEWING RELATIONSHIPS
Hovering over the join between two tables displays the relationship between the two tables.

REMTALITEM (RI)

[5E ITEMNUMEER.: NUMEER.
£= MOVIECOPYID: MUMEER.
[5E RENTALID: NUMBER.

REMTALITEM_FK1
REMTALITEM_FK2
Y5 REMTALITEM_PK

™

Cardinality: Master-Detail
Relations:
MOWIERENTAL I:MR:l ri, REMTALID = mr.REMTALID
== -USTOMERID: NUMBER | Columns:
DUEDATE: DATE E COPYFORMAT: CHAR

EMTALID: MUMBER
== TOTALCHARGE: MUMEBER

[0 _MOWIERENTAL_O

EXPANDING VIEWS IN THE VST DIAGRAM

For example, the following is the default layout from query join table CLIENT (c) to view
TRANSACTIONS (t).

Right-click on the view, and choose Expand View.

&5 EMP_DETAILS_YIEW

t:;,(h Reset Lavout

+I+ Layaut Direckion r
1 ;
2, Show Ratios/Counts

U0 Detail Made

Expand all

£ show Unused Columns
L Show Cbject Crners

T Show Query Mames

(ﬂ Zoam In

Now you can see the objects in the view.
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&3 EMP_DETAILS_VIEW

| & EMPLOYEES (E)|

| 2 DEPARTMENTS (D) |
7

| E Locamions (1]
7

| B counries () ]
MY

REGICNS (R)

FINDING PROBLEMATIC SQL OR SCHEMA
In the Visual SQL Tuning (VST) diagram, a well-formed query would resemble the following:

| B3 CLIENT_TRANSACTION (ct) |

CLIEMT {c) | INVESTMENT (i)

One-to-Many

| B INVESTMENT _TYPE (it) |

Problems such as Cartesian joins, implied Cartesian joins, and many-to-many relationships are
clearly represented in the VST.
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| E CLIENT TRANSACTION |

| & a1 | & ci)

3 ]
™, Fy

Y

BROKER New oo

Cartesian Join
| E2l OFFICE_LOCATION | Many-to-Many

Joins are represented with connecting lines between nodes. The following describes when a
particular type of connecting line is used and the default positioning of the line.

Connecting Lines When used

One-to-One Join relationships are graphed horizontally using blue lines. One-to-one joins
exist when two tables are joined on their primary key.

One-to-Many Join relationships are graphed with the many table above the one table.

P
Cartesian Join shows the table highlighted in red with no connectors to indicate that it is
joined in via a Cartesian join. The query is missing join criteria. A Cartesian join problem could
be resolved by implementing a rewrite suggestion shown in the Generated Cases area of the
Overview tab.
Many-to-Many Join relationships are connected by a red line and the relative location is not
restricted. If master detail information is missing then the VST diagram will have many-to-
P

many connectors. The optimizer can more consistently optimize a well-formed query, so the
query will run faster.

IMPLEMENTING RECOMMENDATIONS ON THE INDEX ANALYSIS TAB

Once you have added tuning candidates to a tuning job, DB Optimizer can analyze the
effectiveness of the indexes in the database and recommend the creation of new indexes
where the new indexes can increase performance.

In the Collect and create indexes table, an index that DB Optimizer recommends that
you create is marked in orange and has a create index icon next to its checkbox.

| _ I_|_'u;|ex_ Mame _ _. Table Owner. Table Mame _Cu:ulu!'nn Mame : Index i
£D IDK_ELIENT_TRH.NE.H.ETIDN_I] SYSTEM CLIENT_TRAMSACTION TRAMSACTION_STATUS Mormnal
L] DCLIEI"-.IT_MULTI SYSTEM CLIENT CLIEMT_FIRST...MT_LAST_MAME Mormal
b D CLIENT_EROKER SYSTEM CLIENT EROKER_ID Mormal
b4 D CLIEMT _IMCOME SYSTEM CLIEMT CLIEMT _HOUSEHOLD _INCOME  Mormal
W [JcLEnT P SYSTEM CLIENT CLIENT_ID Unique
b4 D CLIEMT_TRAMSACTION _BROKER  SYSTEM CLIEMT_TRAMNSACTION BROKER_ID Marrnal
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ACCEPT THE SUGGESTION AND AUTOMATICALLY GENERATE AN INDEX

1

For any recommended index, click the check box to the left of the index you want to create.

For a selected index, you can modify the Index type by clicking in the Index Type column
and then selecting a type from the list: Normal, Bitmap, Reverse Key, Reverse Key
Unique, or Unique.

[E2] Inde:x Anabysis
Collect and create indexes 5 %
Inides: Mame Table Owner Table Mame Coh | Creat
0 [ 10%_MOVIERENTAL_D MOVIES MOWIERENTS TOTALCHARE s -
¢ D CUSTOMER _PK MOVIES CUSTOMER CLISTOMERIC
\’ D MOVIECOPY_PK MOVIES MOVIECOPY HMOVIECOPYH P
'f D REMTALITEM_FK1 MOVIES REMTALITEM REMTALID
@ []ousToMER_IEL MOYIES CUSTOMER LASTMAME
& Mrstovre 1w MMYIFS 1 ISTOMER PHIRIE kil
£ b

Click the Create Index button.
The Index Analysis dialog appears.

To view the index SQL in an editor for later implementation, click the statement and then
click Open in a SQL editor.

4 To run the index SQL and create the index on the selected database, click Execute.

SQL CoODE ASSIST AND EXECUTION

SQL Code Assist is an interface component that enables the development and formatting of
SQL code for the purposes of creating and modifying database objects. It provides a front-end

application for the delivery of code through its object code extraction capabilities.

Code Assist provides a number of key features that assist in the coding process, ensuring

greater accuracy in coding, faster development cycles, and a general increase in efficiency
overall.
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CREATE TABLE dbo.benson

{

job CHAR
sal NUMERIC
loc WUMERIC
COHETRAI

go

pijob PRIMARY EEY CLUSTERED (job)

GETTING STARTEDWITHDB OPTIMIZER

The following key features are provided with SQL Code Assist:

e Code Extraction on page 42

e Code Highlighting on page 43

e Automatic Error Detection on page 43

e Code Complete on page 45

e Hyperlinks on page 45
® Code Formatting on page 45

e Code Folding on page 46
* Code Quality Checks on page 46

In order to access SQL Editor, you need to create a new file or edit existing code from Data

Source Explorer.

Additionally, SQL Project Explorer provides a tree structure for all files created in DB Optimizer.
You can access files from here by double-clicking the file name you want to open as well.
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9 Data Source Explorer E‘? SQL Project Explorer 23 =0

= 55: S0 Project 1
* ;" Cannections
= ﬂ Creation Scripts
= -[Zd] Tables
[i3 dbo.benson (Benson,saf) [datoth 15]
+ =|:'|" General QL
* |k Large Scripts
+ E Unknown Fles
{5 Benson.sql

i Fie,sal
|2 test.sql

To create a new file
Choose File > New > SQL File.

A blank instance of SQL Editor appears in the Workbench. If you save this file, it is
automatically added to the SQL Project Explorer.

To edit an existing file
Use Data Source Explorer or Project Explorer to navigate to the code you want to modify
and double-click it.

An instance of SQL Editor appears in the Workbench, populated with the extracted code of
the specified object or SQL project file.

CODE EXTRACTION

SQL Editor provides the ability to extract the underlying SQL code of database objects
registered in DB Optimizer to provide a front-end application for the development and
modification of data sources in your enterprise.

To extract underlying SQL code

Navigate to a database object in Data Source Explorer and select Extract via the right-click
menu.

The object’s underlying SQL code appears in SQL Editor and is ready for editing and further
modification.

42



GETTING STARTEDWITHDB OPTIMIZER

CODE HIGHLIGHTING

SQL Editor identifies commands and provides syntax highlighting changes that are

automatically added to the code as you add lines, which enables you to clearly and quickly
understand code when you read it in the interface.

The following syntax highlighting is automatically added to lines of code in SQL Editor:

Code Formatting
Comments green italics
SQICommands dark blue
Syntagrrors red underline
Codingrrors red

Additionally, SQL Editor provides a purple change bar in the left-hand column that indicates if a
line of code has been modified from the original text. You can hover over this change bar to view
the original code line. A red square icon in the right-hand column indicates that there are errors
in the code line. You can hover over the icon to view the error count.

= 3

CREATE TABLE dbo.benson

job CHAR (8} MOT MULL,
sal NUMERIC (38, 0) NOT NULL,
loc NUMERIC (38, O) NOT NULL,

COMSTRAINT pjob PRIMARY EKEY CLUSIERED (job)

=]
LB}

&- IF OSJECT _ID("dbo.benscon') IS HOT NULL

The purple change bar indicates if a line of code has been changed from its original text. Hover
your mouse over the change bar to view the original text.

AUTOMATIC ERROR DETECTION

The automatic error detection functionality of the editor highlights errors and typos in the code
as you work in “real time.”
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Automatic error detection automatically identifies and analyzes SELECT, FROM, WHERE,
GROUP BY, HAVING, and ORDER BY statements. If it detects any syntax errors while you type
these statements, the line is automatically flagged by the error icon in the left-hand column of
SQL Editor. You can hover your mouse over the icon to view any errors.

I
1

| 8, *Benson.sql 53

—“CREATE TAELE dbo.ben=zon i
{

job CHAR (8) NOT NULL,

sal NOUMERIC (38, 0) WOT NULL,

lae NUMERIC (38, 0) NOT NULL,

CONSTRAINT pjob PRIMARY KEY CLUSTERED (jcb)

go
IF OBECT ID('dbo.benson') IS5 NOT NULL
FRINT '"<<< CERERTED TAHLE dbo.benscn »>»>°'

ELSE

|
% lin unexpected token " << >>" was found. Expected COLON Lon|

Additionally, all semantic errors are recorded in the Problems view, an interface component that
automatically logs errors and warnings as you work with files.

_:PrnblcrnsE;-. iR
3 errors, 0 warnings, 0 infos
Description = Resource Path Location
Bl &= Errores (3 items)
@ &nunexpected token =< << FAILED CR Benson.sql S0L Project 1 in= 14
3 An unexpected token ™" was found, Bxg File.sdl S0 Project 1 e &
3 Table benson carnot be resolved on 'da Senson.sql SQL Project 1 ine 19

The Problems view logs errors and warnings as you work with files in SQL Editor.

You can double-click on a line in the Problems view and DB Optimizer will automatically
navigate you to that issue in SQL Editor.
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CoDE COMPLETE

SQL Editor provides suggestion capabilities for both DML statements and objects. It has the
ability to look up object names in order to avoid errors when defining table names, columns, etc.
in the development process. This feature provides lists of object and code suggestions that will
make the development process more efficient as you will not be forced to manually look up
object names and other statement values. SQL Editor provides code assist for SELECT, UPDATE,
INSERT, and DELETE statements (as well as for MERGE statements on SQL Server 2008 and
higher) and object suggestion support for tables, alias tables, columns, alias columns, schemas,
and catalogs.

To activate code assist

1 Click the line on which you want to activate the code assist feature.

2 Press CTRL + Spacebar on your keyboard. Code assist analyzes the line and presents a list
of suggestions as appropriate based on the elements of the statement.

HYPERLINKS

Hyperlinks are used in SQL Editor to provide links to tables, columns, packages and other
reference objects. When you select a hyperlinked object from a piece of code, a new editor
opens and displays the source. Additionally, hyperlinks can be used to link procedures or the
function of a call statement, as well as function calls in DML statements. To enable a hyperlink,
hover your mouse over the object name and hold the CTRL key. It becomes underlined and
changes color.

CODE FORMATTING

Code formatting is automatically applied to a file as you develop the file in SQL code. This
enables you to set global formatting preferences one time, and then apply them to all code
development, saving time and allowing for a more efficient code development process. The
code formatter can be accessed by selecting CTRL + Shift + F in the editor. All code is
automatically formatted based on parameters specified on the Code Formatter node of the
Preferences panel. (Select Window > Preferences in the main menu to access this panel.)
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HPrternens NG
type filber text Code Formatter o
¥ mal Select a profile:
*- Help : ke i
# Instal Upoate Embarcaders [built-in] w| | show... ]
#l- License Manager
3 RunDsbug
=I- SQL Develooment Preview:
CRcl S CREATE TABLE colTable -
Loggrg (
) oo coll INMT,
m :‘:TI:;“H eoll? INT,
Resuts Viewsr col3 INT,
Syntax Coloring cold VARCHAR (30)
50L Execution L
S0L Fitters
2 Team INSERT
INTC colTable
VALUES
f
9,
8,
g,
'teat v!
[Restore Defauits | [ Apply |
: [ QK ] i Cancel j

In addition to formatting code per individual file, you can also format an entire group of files
from Project Explorer. Select the directory of files that you want to apply formatting to and
execute the Format command from the right-click menu. The files will be automatically
formatted based on the global preferences.

CODE FOLDING

The code folding feature automatically sorts code into a tree-like outline structure in SQL Editor.
This increases navigation and clarification capacities during the code development process. It
ensures that the file will be easily understood should any future work be required on the code. As
you work in SQL Editor, collapsible nodes are automatically inserted into the appropriate lines of
code. Statements can then be expanded or collapsed as needed, and this feature is especially
useful when working on parts of particularly large or complicated files.

CobDE QuALITY CHECKS

On Oracle-based code, the code quality checking feature provides suggestions regarding
improved code on a statement-by-statement basis. As you work in SQL Editor, markers provide
annotations that prevent and fix common mistakes in the code.
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Notes regarding code quality suggestions appear in a window on any line of code where the
editor detects an error, or otherwise detects that the code may not be as efficient as it might be.
Code quality check annotations are activated by clicking the light bulb icon in the margin, or by
selecting Ctrl + | on your keyboard.

The following common errors are detected by the code quality check function in the editor:

e Statement is missing valid JOIN criteria

Invalid or missing outer join operator

Transitivity issues

Nested query in WHERE clause

Wrong place for conditions in a HAVING clause

Index suppressed by a function or an arithmetic operator

Mismatched or incompatible column types
e Null column comparison
To activate code quality checks:
e Click the light bulb icon in the margin of the editor or select Ctrl + | on your keyboard.

The editor suggestions appear in a window beneath the selected statement. When you click
a suggested amendment, the affected code is automatically updated.

SQL EXECUTION

When you have finished developing or modifying code, you can then execute the file from within
the DB Optimizer environment, on the database of your choosing. This enables you to
immediately execute code upon completion of its development. Alternatively, you can save files
for execution at a later point in time.

In order to execute a file, you must first associate it with a target database. This is performed by
using the drop-down menus located in the Toolbar. When a SQL file is open in the Workbench,

the menus are enabled. Select a data source and a corresponding database to associate the file
with and then click the green arrow icon to execute the file.
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i Untited SQL.sgl (=g &l _
b '} Oracle b T3 TORLABSCORCL (MOVIES) (10,2.0,1) B g i
[l

=I-=F Data Source Group
+1-1=F Microsoft SOL Server
=I-1=F Cracle
ﬁE]ROMLﬁBORCLﬁ_I
S ROMLABORCLY_Z =
i| sfypclb0l embarcadera,com
i| TORLABORCLE_2
ﬁi]TORLAEORCLﬁ_l
S TORLABSCORCL
.9!' TORLAESCORCL (MONIES)
+-T=F Microsaft 0L Server

c2.phone hetween 2625569900 and 29939569200 and
round (ri.rentalid) > 10 and
trunc (ri.itemnumber) > 1 and
mr.totaleharge > (gelect avg (totalcharge)
fromwm MOVIES .movierental) and
ri.mmoviecopyid not in (select mo.moviecopyid w

Code

The pair of drop-down menus indicates that the SQL file is associated with the dataotb19 data
source and EMBCM database. When the green arrow icon on the right-hand side of the menus
is selected, the file is executed on the specified data source and database.

Additionally, if you have turned off auto-committal in the Preferences panel (Window >
Preferences) you can commit and execute transactions via the Commit Transaction and
Start Transaction icons located beside the Execute icon.

EXECUTE A FILE

Open the file you want to run and ensure it is associated with the correct database, then click the
Execute icon [E¥] . DB Optimizer executes the code on the database you specified.

EXECUTE A TRANSACTION

Open the transaction file you want to run and ensure it is associated with the correct database,
then click the Start Transaction icon [f]. DB Optimizer executes the transaction on the
database you specified.
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CoOMMIT A TRANSACTION

Open the transaction file you want to commit, ensure it is associated with the correct database,
and click the Commit Transaction icond ]. DB Optimizer commits the transaction on the
database you specified.

CONFIGURING SQL EXECUTION PARAMETERS

Use the SQL Session Options dialog to modify the configuration parameters that determine
how DB Optimizer executes code. These options ensure that code is executed the way you want
on an execution basis, ensuring accuracy and flexibility when running new or modified code.

& SOL Session Options

S0L Session Options
Specify the SQL session opkions for the current editar,
Property Yalue
—| Result Set
Maximum Rows in Result Sek ]
Maximum Mumber of Bytes ina ... 2048
Cuery Timeout {seconds) 1]
—| Transactions
AukaiZornrnik krue
.
C?_) [ Finish ] [ Cancel

SQL Sessions Options provide you with the flexibility to adjust execution parameters on a
session-by-session basis.

MoDIFY SQL SESSION OPTIONS

1 Click the SQL Session Options icon on the toolbar. The SQL Sessions Options
dialog appears.

2 Click on the individual parameters in the Value column to change the configuration of each
property, as specified.

3 Click Finish. The session options are changed and DB Optimizer executes the code as
specified by your options.

NOTE: SQL Session Options are only applied to the currently-selected code, and are not
retained across different files with regards to execution.
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